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Introduction 

There are more symbols used in mathematics than are shown on a 

standard keyboard. Whilst there are various ways to generate additional 

symbols this document has been written to help with two specific 

methods within Microsoft Word. Consideration has also been given to the 

result when these symbols are translated into Braille using the Duxbury 

Braille Translator software. 

I am grateful to James Bowden for the guidance and support he has 

provided in the creation of this document. 

 

David Spybey 

March 2017 

 

 

Microsoft Word 

Microsoft Word has many built in mathematical symbols that can be 

created using its Math AutoCorrect feature. It is a useful feature which 

can be used if you do not have mathematical typesetting software or if 

you are writing mathematics which does not contain complex notation. 

The tables below show a wide range of mathematical symbols that will 

translate correctly into UEB using the Duxbury Braille Translator (11.3 or 

12.1). Other braille translation software may also translate these symbols 

correctly. 

The entries in the "Print Outcome" column in all the tables are shown in 

the font Cambria Math. The "Normal" font used in a document may affect 

the style of the print outcome and more detail is provided in Appendix A.  

To find a full list of symbols that can be generated using Math 

AutoCorrect go to https://support.office.com and search for "math 

autocorrect".  
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Setting up Math AutoCorrect in WORD 

The explanation below is based on a Microsoft web page. 

The reference to the font Cambria Math may be unnecessary but there 

are some symbols that are preferable in this font and more information 

about this is given in Appendix A. 

Appendix B provides details of how to set up Math AutoCorrect for those 

who are not using a mouse or mouse pad. 

*************** 

To insert a Math AutoCorrect symbol, type one of the codes given in the 

tables below followed by a delimiting term. For example, after you type a 

code, type a punctuation mark, or press SPACEBAR or ENTER. To 

ensure that the Math AutoCorrect symbols appear the same in your 

document as they do in the AutoCorrect dialog box, on the Home tab, in 

the Font group, select Cambria Math. 

To insert a Math AutoCorrect symbol outside of an equation, you need to 

select the Use Math AutoCorrect rules outside of math regions check 

box in the AutoCorrect dialog box. 

Use Math AutoCorrect rules outside of an equation 

Click the Microsoft Office Button , and then click Word Options. 

Click Proofing, and then click AutoCorrect Options. 

Click the Math AutoCorrect tab. 

Select the Use Math AutoCorrect rules outside of math regions 

check box. 

*************** 
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Using Unicode 

Unicode is a computing industry standard for the encoding of text and 

symbols. Some Unicode values contain a letter and the standard way to 

display these codes uses capital letters but lower case letters work 

equally well. For example, 25A1 and 25a1 both lead to a hollow square. 

To use Unicode type the symbol's Unicode value and then Alt+X, i.e. 

after the Unicode value hold down the Alt key and tap the X key. 

You cannot have a number, or one of the letters a-f, before the Unicode 

value so it may be necessary to insert a space before the Unicode value 

and then delete it afterwards.  

Problems with entry method 

There are potential issues with both Math AutoCorrect and Unicode. 

For example, to get 4√3 using Math AutoCorrect a space or punctuation 

is needed after the root sign and this needs to be deleted before typing 

the 3. To get 4√3 using Unicode there needs to be a space before typing 

the Unicode value 221A for the root sign and this space needs to be 

deleted at some stage. 

It should also be noted that the font following the insertion of one of 

these symbols may result in a font change from the "Normal" document 

font and more detail of this is given in Appendix A. 

Grade 1 indicators and spacing 

When material is written using an equation editor, such as MathType, the 

translation software will generally space the material following UEB 

guidance and it will use a mixture of grade 1 symbol/word/passage 

indicators.  

When material is written using either Unicode or Math AutoCorrect the 

translation software is likely to follow the spacing of the print material and 

it will only make use of grade 1 symbol indicators.  

Some of the symbols in the following tables need to be in grade 1 and 

will require an indicator  which sets up grade 1 before them.  A full list of 

these symbols is given in Appendix C.  
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Table of symbols and codes 

Math  

AutoCorrect 
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\angle 2220 ∠ _[ angle sign 

\approx 2248 ≈ ^9 
approximately equal 

to 

\ast 2217 ∗ "9 asterisk 

\because 2235 ∵ @/ because, since 

\bot 22A5 ⊥ #- perpendicular to 

\box 25A1 □ $#d hollow square 

\cap 2229 ∩ .8 intersection 

\cdot 22C5 ⋅ "4 
dot operator, 

multiplication dot 

\circ 2218 ∘ "0 hollow dot 

\cong 2245 ≅ "_9 is congruent to 

\cup 222A ∪ .6 union 

\dashv 22A3 ⊣ @_3 reverse assertion 

\degree 00B0 ° ^j degrees 

\div 00F7 ÷ "/ division sign 

\dots 2026 … 444 ellipsis 

\downarrow 2193 ↓ \% down arrow 

\Downarrow 21D3 ⇓ \7% down double arrow 

\emptyset 2205 ∅ @j empty set 

\equiv 2261 ≡ _= equivalent 

\exists 2203 ∃ ^5 there exists 

\forall 2200 ∀ ^a for all 

\ge 2265 ≥ _@> 
greater than or equal 

to 

\geq 2265 ≥ _@> 
greater than or equal 

to 
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Math  

AutoCorrect 
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\gets 2190 ← \[ left arrow 

\gg 226B ≫ .@> much greater than 

\hbar 210F ℏ @3h Dirac constant, h-bar 

\hookleftarrow 21A9 ↩ \5533[ left arrow with hook 

\hookrightarrow 21AA ↪ \9933o right arrow with hook 

\in 2208 ∈ ^e is an element of 

\inc 2206 ∆ ,.d 

increment, Laplace 

operator, same as 

capital delta 

\infty 221E ∞ #= infinity 

\int 222B ∫ ! integral 

\langle 2329 〈 @< 
left pointing angle 

bracket 

\lbrace 007B { _< left curly bracket 

\lbrack 005B [ .< left square bracket 

\ldots 2026 … 444 ellipsis 

\le 2264 ≤ _@< less than or equal to 

\leftarrow 2190 ← \[ left arrow 

\Leftarrow 21D0 ⇐ \7[ left double arrow 

\leftharpoondown 21BD ↽ \,r[ 
left harpoon with 

barb downwards 

\leftharpoonup 21BC ↼ \@r[ 
left harpoon with 

barb upwards 

\leftrightarrow 2194 ↔ \wro left right arrow 

\Leftrightarrow 21D4 ⇔ \w7ro 
left right double 

arrow 

\leq 2264 ≤ _@< less than or equal 

\ll 226A ≪ .@< much less than 

\mapsto 21A6 ↦ \\ro right arrow from bar 
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Math  

AutoCorrect 
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\matrix 25A0 ■ _$#d solid square 

\minus 2212 − "- minus sign 

\models 22A8 ⊨ ^_3 is valid 

\mp 2213 ∓ _- minus or plus 

\nabla 2207 ∇ ^d nabla 

\ne 2260 ≠ "7@: not equal to 

\nearrow 2197 ↗ \s northeast arrow 

\neq 2260 ≠ "7@: not equal to 

\ni 220B ∋ @^e 
contains as an 

element 

\nwarrow 2196 ↖ \: northwest arrow 

\oint 222E ∮ @! closed line integral 

\ominus 2296 ⊖ $=["- minus sign in a circle 

\oplus 2295 ⊕ $=["6 plus sign in a circle 

\over 002F / _/ forward slash 

\parallel 2225 ∥ #l is parallel to 

\partial 2202 ∂ @d curly d 

\pm 00B1 ± _6 plus or minus 

\pprime 2033 ″ 77 double prime 

\prime 2032 ′ 7 prime  

\prod 220F ∏ ,.p 
product operator, 

capital Greek pi 

\propto 221D ∝ _"7 proportional to  

\rangle 232A 〉 @> right angle bracket 

\ratio 2236 ∶ 3 ratio, colon 

\rbrace 007D } _> right curly bracket 

\rbrack 005D ] .> right square bracket 

\rightarrow 2192 → \o right arrow 
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Math  

AutoCorrect 
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\Rightarrow 21D2 ⇒ \7o right double arrow 

\rightharpoondown 21C1 ⇁ \,ro 
right harpoon with 

barb downwards 

\rightharpoonup 21C0 ⇀ \@ro 
right harpoon with 

barb upwards 

\searrow 2198 ↘ \< southeast arrow 

\sim 223C ∼ @9 tilde 

\simeq 2243 ≃ _9 
approximately equal 

to 

\sqrt 221A √ "% square root 

\subset 2282 ⊂ ^< subset of 

\subseteq 2286 ⊆ _^< subset of or equal to 

\sum 2211 ∑ ,.s 
summation sign, 

capital Greek sigma 

\superset 2283 ⊃ ^> superset of 

\superseteq 2287 ⊇ _^> 
superset of or equal 

to 

\swarrow 2199 ↙ \> southwest arrow 

\times 00D7 × "8 multiplication sign 

\therefore 2234 ∴ ;,* therefore 

\updownarrow 2195 ↕ \wr+ up down arrow 

\Updownarrow 21D5 ⇕ \w7r+ 
up down double 

arrow 

\vdash 22A2 ⊢ _3 assertion 

\vee 2228 ∨ @6 logical or 

\vert 007C | _\ vertical bar 

\wedge 2227 ∧ @8 logical and 
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Playing card symbols 

The following playing card symbols are translated into words.  

 

Math 

AutoCorrect 
Unicode 

Print 

outcome 
Braille  translation Description 

\clubsuit 2663 ♣ 
@$<black club 

suit> 
club suit sign 

\diamondsuit 2662 ♢ 
@$<white 

diamond suit> 

diamond suit 

sign 

\heartsuit 2661 ♡ 
@$<white 

heart suit> 
heart suit sign 

\spadesuit 2660 ♠ 
@$<black 

spade suit> 
spade suit sign 
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Greek letters 

Notes:  

\epsilon (Unicode 03F5) gives the symbol ϵ which is a "lunate epsilon" 

and this currently translates as @$u"6#c;f#e which is not correct. 

\varsigma (Unicode 03C2) gives the symbol ς but this symbol is not 

recognised in UEB and the current translation .@s is not correct UEB 

code.  

 

Math 

AutoCorrect   
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\alpha 03B1 α .a alpha 

\Alpha 0391 Α ,.a capital alpha 

\beta 03B2 β .b beta 

\Beta 0392 Β ,.b capital beta 

\gamma 03B3 γ .g gamma 

\Gamma 0393 Γ ,.g capital gamma 

\delta 03B4 δ .d delta 

\Delta 0394 Δ ,.d capital delta 

\varepsilon 03B5 ε .e epsilon 

\Epsilon 0395 Ε ,.e capital epsilon 

\zeta 03B6 ζ .z zeta 

\Zeta 0396 Ζ ,.z capital zeta 

\eta 03B7 η .: eta 

\Eta 0397 Η ,.: capital eta 

\theta 03B8 θ .? theta  

\Theta 0398 Θ ,.? capital theta 

\iota 03B9 ι .i Iota 

\Iota 0399 Ι ,.i capital iota 

\kappa 03BA κ .k kappa 

\Kappa 039A Κ ,.k capital kappa 

\lambda 03BB λ .l lambda 
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Math 

AutoCorrect  
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\Lambda 039B Λ ,.l capital lambda 

\mu 03BC μ .m mu 

\Mu 039C Μ ,.m capital mu 

\nu 03BD ν .n nu 

\Nu 039D Ν ,.n capital nu 

\xi 03BE ξ .x xi 

\Xi 039E Ξ ,.x capital xi 

\o 03BF ο .o omicron 

\O 039F Ο ,.o capital omicron 

\pi 03C0 π .p pi 

\Pi 03A0 Π ,.p capital pi 

\rho 03C1 ρ .r rho 

\Rho 03A1 Ρ ,.r capital rho 

\sigma 03C3 σ .s sigma 

\Sigma 03A3 Σ ,.s capital sigma 

\tau 03C4 τ .t tau 

\Tau 03A4 Τ ,.t capital tau 

\upsilon 03C5 υ .u upsilon 

\Upsilon 03A5 Υ ,.u capital upsilon 

\phi 03D5 ϕ .f open or loopy phi 

\varphi 03C6 φ .f phi 

\Phi 03A6 Φ ,.f capital phi 

\chi 03C7 χ .& chi 

\Chi 03A7 Χ ,.& capital chi 

\psi 03C8 ψ .y psi 

\Psi 03A8 Ψ ,.y capital psi 

\omega 03C9 ω .w omega 

\Omega 03A9 Ω ,.w capital omega 
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Examples using Math AutoCorrect 

Example 1 

Type Print Braille translation 

\sqrt 49 = 7 √49 = 7 "%#di "7 #g 

 

Here, after typing \sqrt and pressing space, the backspace key was used 

before the 4 so that the result was √49 and not √ 49.  

 

Example 2 

Type Print Braille translation 

36\div 8 = 4.5 36÷8 = 4.5 #cf"/#h "7 #d4e 

 

Here, after typing \div and pressing space, the backspace key was used 

before the 8 so that the result was ÷8 and not ÷ 8. 

The braille translation follows the spacing in the print so there is no 

space around the ÷ sign but there is a space before and after the = 

sign in the text in order to get the desired spacing in the braille. 

 

Example 3 

Type Print Braille translation 

\alpha \mapsto \alpha+\beta α ↦ α+β .a ;\\ro .a"6.b 

 

This example demonstrates the ease of this method for some material as 

there was no need to insert extra spaces or delete any spaces. 
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Adding more! 

It is possible to add to the Math AutoCorrect options but these will not 

necessarily translate correctly.  

Example:  

You may choose to set your copy of Word so that it changes 1/4 to ¼ 

automatically.  

One way to do this is to go to Insert→Symbol→More Symbols and find 

the symbol ¼. With this symbol highlighted go to the AutoCorrect  button 

and type 1/4 (you could choose \1/4 if you wished) in the Replace box. 

The Duxbury Braille Translator translates ¼ correctly but if you try a 

symbol such as the tick symbol  then, as there is currently no UEB 

coding for this symbol, it is not surprising if this symbol is simply missed 

out.  
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Appendix A 

Fonts 

The material from the Microsoft web page mentioned "on the Home tab, 

in the Font group, select Cambria Math". This seems to be unnecessary 

for most symbols. 

When using the Math AutoCorrect in any font the resulting print symbol 

seems to be automatically changed into Cambria Math if the current font 

does not have the print symbol in it.  

So \subset  written in most fonts results in ⊂ in Cambria Math.  

In the same way using Unicode 2282 results in ⊂ in Cambria Math. 

This may seem to be helpful but there is a potential drawback when 

using Unicode. If the symbols are being entered as they occur in the text 

the change of font can affect the font of the following text.  

For example  

The text below starts in Arial. In (1) the symbol was obtained using Math 

AutoCorrect and in (2) Unicode was used.  

1. Here is a subset ⊂, it is used to indicate

2. Here is a subset ⊂, it is used to indicate

The ⊂ symbol has automatically been written in Cambria Math. 

Using Math AutoCorrect inserts a space after the symbol, this has been 

deleted in the above text, but retains the Arial font for the subsequent 

text.  

Using Unicode there is no space after the symbol but the change in font 

to Cambria Math is continued in the following text.  
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The following shows an example which again uses the Arial font,  

(1) used Math AutoCorrect and (2) used Unicode. It all stays in Arial as 

the symbols are available in the Arial font. The font Cambria Math is not 

present in any of the resulting text.  

 

1. The summation sign ∑, is the same as a capital sigma Σ but it is 

clearly larger in the print. 

2. The summation sign ∑, is the same as a capital sigma Σ but it is 

clearly larger in the print.  

 

Whilst Arial, or some other font, may be fine for most symbols the table 

below show some symbols where the Cambria Math font may be 

preferred.  

 

Math 

AutoCorrect 
Unicode Arial 

Cambria 

Math 
Description 

\infty 221E ∞ ∞ infinity 

\matrix 25A0 ■ ■ solid square 

\sqrt 221A √ √ square root 

\sum 2211 ∑ ∑ summation sign 

\times 00D7 × × multiplication sign 

\gamma 03B3 γ γ gamma 

\Gamma 0393 Γ Γ capital gamma 

\delta 03B4 δ δ delta 

\kappa 03BA κ κ kappa 

\lambda 03BB λ λ lambda 

\Lambda 039B Λ Λ capital lambda 

\nu 03BD ν ν nu 

\pi 03C0 π π pi 

\tau 03C4 τ τ tau 

\upsilon 03C5 υ υ upsilon 

\chi 03C7 χ χ chi 
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When preparing documents changing between the Normal font and 

Cambria Math can be a be a nuisance and it may well be helpful to set 

up a "Style" in Word to help.  

If you create a new style called "Maths" create it as a "Character style" 

and make the font "Cambria Math". The size of the font may be left blank 

so that the Maths style will pick up the size of the Normal font used in the 

document. Setting up a shortcut key for the style at this stage will make it 

easier to use.  

Ctrl+spacebar  is a shortcut for returning to the Normal style.  

If the shortcut chosen for the "Maths" style is Ctrl+Alt+# then the 

following key entry can be used.  

To obtain: 

The value of π is 3.142 to three decimal places. 

Using Math AutoCorrect 

Type: The value of [space] 

Press: Ctrl+Alt+# 

Type : \pi 

Press: Ctrl+spacebar 

Type: [space] is 3.142 to three decimal places. 

Using Unicode 

Type: The value of [space] 

Press: Ctrl+Alt+# 

Type : 03C0 

Press: Alt+X 

Press: Ctrl+spacebar 

Type: [space] is 3.142 to three decimal places. 
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Appendix B 

Setting up Math AutoCorrect in WORD without using 

a mouse 

Math AutoCorrect only needs to be set up once. 

The following provides the key strokes to use and describes the effect of 

the key strokes.  

Alt+F this opens the Microsoft Office Button 

Alt+I this opens "Word Options"  

Ctrl+Tab to find  "Proofing" 

Once "Proofing" has been found then tab, once, to the 

"AutoCorrectOptions" and press Enter 

At this point there are five tabs 

AutoCorrect 

Math AutoCorrect 

AutoFormat As You Type 

AutoFormat 

Smart Tags 

Ctrl+Tab until  "Math AutoCorrect" is found. 

In this dialog there are two check boxes to tick.  

"Use Math AutoCorrect rules outside of math regions" 

and 

"Replace text as you type"  

Tab to each check box and if needed press Space to check the box. 

Finally, Tab to the OK button to close the changes. Then exit the main 

Word Options dialog similarly.  
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Appendix C 

Symbols which must be in grade 1 

All the symbols in the following table need to be in grade 1 as they have 
an alternative grade 2 meaning. Grade 1 may be set up by a grade 1 
symbol/word/passage indicator or by a numeric indicator.  

Math  

AutoCorrect 
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\box 25A1 □ $#d hollow square 

\downarrow 2193 ↓ \% down arrow 

\Downarrow 21D3 ⇓ \7% down double arrow 

\gets 2190 ← \[ left arrow 

\hookleftarrow 21A9 ↩ \5533[ left arrow with hook 

\hookrightarrow 21AA ↪ \9933o right arrow with hook 

\int 222B ∫ ! integral 

\leftarrow 2190 ← \[ left arrow 

\Leftarrow 21D0 ⇐ \7[ left double arrow 

\leftharpoondown 21BD ↽ \,r[ 
left harpoon with 

barb downwards 

\leftharpoonup 21BC ↼ \@r[ 
left harpoon with 

barb upwards 

\leftrightarrow 2194 ↔ \wro left right arrow 

\Leftrightarrow 21D4 ⇔ \w7ro 
left right double 

arrow 

\mapsto 21A6 ↦ \\ro right arrow from bar 

\nearrow 2197 ↗ \s northeast arrow 

\nwarrow 2196 ↖ \: northwest arrow 

\ominus 2296 ⊖ $=["- minus sign in a circle 

\oplus 2295 ⊕ $=["6 plus sign in a circle 

\rightarrow 2192 → \o right arrow 
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Math  

AutoCorrect 
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\Rightarrow 21D2 ⇒ \7o right double arrow 

\rightharpoondown 21C1 ⇁ \,ro 
right harpoon with 

barb downwards 

\rightharpoonup 21C0 ⇀ \@ro 
right harpoon with 

barb upwards 

\searrow 2198 ↘ \< southeast arrow 

\swarrow 2199 ↙ \> southwest arrow 

\therefore 2234 ∴ ,* therefore 

\updownarrow 2195 ↕ \wr+ up down arrow 

\Updownarrow 21D5 ⇕ \w7r+ 
up down double 

arrow 

Note: 

Math 

AutoCorrect  
Unicode 

Print 

outcome 

Braille 

translation 
Description 

\pprime 2033 ″ 77 double prime 

\prime 2032 ′ 7 prime 

Prime and double prime are unusual symbols as they may or may not 

need to be in grade 1.  

If they are immediately preceded and followed by a letter then they need 

to be in grade 1 as they would represent  "gg". Otherwise their meaning 

is not ambiguous and they do not need to be in grade 1. . 
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